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APLICAÇÕES: 

 

 COMUNICAÇÃO Ethernet TCP/IP ENTRE 4 CLP’S: 

 

01- CONFIGURAÇÃO CLP 01 ESCRAVO: 

1. Click em Tools > Network Manager; 

2. New > Escolha um nome > Escolha o modelo do CLP; 

3. Online > Connect, 

4. Online > Read IO Information; 

5. Dois clicks em 01: FEnet; 

6. Abrirá a seguinte tela: 

 

Configure os parâmetros conforme a tela acima.   
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7. Click em Msdbus Settings: 

 

 

 

Configurar os parâmetros conforme a tela acima. Isto significa que as informações que forem 

disponibilizadas pelo CLP Escravo para leitura, deverão ser colocadas na memória D0 do CLP Escravo. 

Quando o CLP Mestre solicitar a leitura, os dados que estão na memória D0 do CLP Escravo serão 

transferidos para uma memória no CLP Mestre. Quando o CLP Mestre escrever algum dado no CLP 

Escravo, este dado aparecerá na memória D10 do CLP Escravo.    
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8. Para os demais CLP’S deve-se repetir os passos anteriores, mudando apenas o Station Number 

e o IP adress para cada CLP, conforme a tela abaixo:  

 

 

 

9. Click em Online > Write Parameter; 
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02- CONFIGURAÇÃO CLP MESTRE: 

 

1- Click em Tools > Network Manager; 

2- New > Escolha um nome > Escolha o modelo do CLP; 

3- Online > Connect, 

4- Online > Read IO Information; 

5- Dois clicks em FEnet: 
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6- Configure os dados conforme a tela abaixo: 

 

 

 

Lembrando que a faixa de IP de todos os CLP’S tem que ser a mesma. Nesse exemplo nosso CLP 

Mestre ficou com o final 5.l 

O “No of  Dedicated Connection” precisa estar em 1 para comunicação de 3 escravos. 
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7- Cick em P2P(EIP): 

 

 

 

 

8- Click 2 vezes em P2P 03. Na tela “Communication Module Settings” selecione o Slot que se 

encontra o módulo de comunicação TCP IP (XBL-EMTA). Neste exemplo o módulo se encontra 

no Slot 6: 
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9- Click 2 vezes em P2P Channel: 

 

 

 

10- Configure conforme a tela abaixo, colocando os endereços IP’s configurados anteriormente 

nos Escravos: 
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11- Click 2 vezes em P2P Block: 

 

 

12- Agora iremos configurar todos os endereços de LEITURA do CLP Mestre: 

  

 Ch / Driver Settings – Configurado no passo 10; 

 P2P – Configurado para leitura de dados; 

Conditional Flag – Toda vez que as memórias M100, M101, M102 forem para nível  lógico 

alto o CLP Mestre realiza a leitura; 

 Date Size – Espaço reservado para os dados, ou seja, 10 words; 

Destination Station Number –  Configurado no passo 9 do item 01- Configuração CLP  01 

Escravo; 
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13- Click em settings e configure as memórias de leitura. Neste exemplo configuramos as 

memórias: D0, D10 e D20. Isto significa que essas memórias são as que receberão dados 

armazenados na memória D0 dos CLP’s Escravos.  

 

- D0 até D9 – Recebimento de Dados da Memória D0 do Escravo 1; 

- D10 até D19 – Recebimento de Dados da Memória D0 do Escravo 2; 

- D20 até D29 – Recebimento de Dados da Memória D0 do Escravo 3; 

 

 

14- Agora iremos configurar todos os endereços de ESCRITA do CLP Mestre: 
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15- Click em settings e configure as memórias de escrita. Neste exemplo configuramos as 

memórias: D30, D40 e D50. Isto significa que essas memórias são as memórias que enviarão os 

dados para a memória D10 dos CLP’s Escravos.  

 

 

- D30– Envio de Dados para Memória D10 do Escravo 1; 

- D40– Envio de Dados para Memória D10 do Escravo 2; 

- D50– Envio de Dados para Memória D10 do Escravo 3; 
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16- Click em Online > Write Parameter; 

17- Click em Online > Enable Link; 

18- Marque a opção P2P(EIP) 03 e click em Write > Ok > Close: 

 

 

19- Agora, no programa do CLP Mestre, nós precisamos criar um contador para acionamento 

automático das memórias de “Condition Flags”: 

 

Transfira este programa para o CLP Mestre;  
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20- Para realizar um teste, abra dois XG5000, um com o programa do Mestre e outro com o 

programa de um dos Escravos; 

21- No programa do CLP Mestre, Click em Monitor > Device Monitoring  > Selecione D; 

22- No programa do CLP Escravo, Click em Monitor > Device Monitoring > Selecione D; 

23- No Device Monitoring do CLP Mestre digite um valor na memória D30, D40 ou D50 e este valor 

será lido pelo Escravo e aparecerá na memória D10 do respectivo escravo; 

24- Em um dos escravos digite um valor na memória D0 e este valor será lido pelo Mestre e 

aparecerá em uma das memórias D0, D10 ou D20 conforme o escravo. 

 

  

 

 

 

 

 

 

 

 

 

Neste exemplo acima, foi escrito o valor 50 na memória D50 do CLP Mestre e este valor foi lido 

(transferido) pela memória D10 do Escravo 3.  

Também foi escrito o valor 10 na memória D0 do CLP Escravo 3 e este valor foi lido (transferido) pela 

memória D50 do Mestre. 

 

 FIM. 
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 COMUNICAÇÃO Ethernet: CLP XGB / XBL EMTA  

- No XG5000: 

1. Click em Tools > Network Manager para abrir o XG-PD; 

2. New > Escolha um nome > Escolha o modelo do CLP; 

3. Click  em Online > Conect; 

4. Click em Online > Read IO Information; 

5. Click 2 vezes em FEnet; 
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6. Configure os parâmetros que serão utilizados para o módulo XBL-EMTA, conforme a tela 

abaixo e click em OK: 
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7- Click em P2P(EIP) na parte inferior esquerda da tela; 

 

 

 

8- Click 2x em P2P 03 e selecione FEnet e o slot que o modulo se encontra, no caso deste 

exemplo, no slot 6. Click em OK: 
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9- Click 2 vezes em P2P Chanel e configure os parâmetros conforme a tela abaixo: 

   

 

 

  10 – Click com o botão direito em User frame definition > Add Group: 
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11- Preencha o Group name e selecione em Frame type: Transmission, pois nesse caso queremos 

enviar dados do CLP para o Computador via Ethernet:  

 

 

12 – Click com o botão direito em Contador [Transmission] e selecione Add Frame: 

 

 

13 – Defina os parâmetros conforme a tela abaixo e click em OK: 
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14- Click com o botão direito na tela branca à direita e selecione Add Segment: 

 

 

15- Configure os Parâmetros conforme a tela abaixo: 

 

02: STX em Hexadecimal; 
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16 – Click  novamente com o botão direito em Contador [Transmission] selecione Add Frame: 

 

 

 

17 – Defina os parâmetros conforme a tela abaixo e click em OK: 

 

 

18- Click com o botão direito na tela branca à direita e selecione Add Segment: 
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19- Configure os Parâmetros conforme a tela abaixo:  

 

03: ETX em Hexadecimal; 

 

20 – Click  novamente com o botão direito em Contador [Transmission] selecione Add Frame: 
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21 – Defina os parâmetros conforme a tela abaixo e click em OK: 

 

 

22- Click com o botão direito na tela branca à direita e selecione Add Segment: 

 

 

23- Configure os Parâmetros conforme a tela abaixo:  
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24- Click 2 vezes em P2P Block e configure os parâmetros conforme a tela abaixo: 

 

 

 

Click em setting e configura conforme a tela abaixo: 

 

 

Neste exemplo colocamos em Read área a memória D0. Isto significa que serão lidos os dados 

contidos na memória D0 e enviados via Ethernet para o computador de destino. 
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25. Click em Online > Write Parameter e em seguida em OK: 

 

 

26- Click em Online > Enable Link: 
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27- Como a configuração foi feito a configuração no P2P03, marque esta opção para ser 

habilitada e em seguida click em Write > OK > Close: 
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28- Podemos realizar um teste utilizando um programa para comunicação Ethernet, neste exemplo 

utilizamos o Software Hercules para ler os dados enviados do CLP para o Computador. Configure 

conforme a tela abaixo e click em Listen:  
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29- Quando a memória M57 for para 1, como configurado anteriormente, será enviado o dado que 

está na memória D0 para o software Hercules como na figura abaixo: 

 

 

Fim. 
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 Criando um Script para IHM 

 

1. No XP-Builder click com o botão direito em Script > Insert: 
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2. Digite o código conforme a tela abaixo; 

 

 

 

3. Volte à tela B-1: 
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4. Na tela principal B-1 crie um Bit Switch nomeado como M0 igual a imagem abaixo: 
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5. Click com o botão direito na tela e em seguida click em Screen Property: 
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6. Click em Etc. e em seguida em Add & Modify: 
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7. Selecione o Script criado em Script Name; 

8. Em Execution Condition, selecione Consecutive; 

9. Click em Insert; 

 

 

10. Click em Ok e depois OK novamente; 

11. Transfira o programa para a IHM; 

12.  

Agora, toda vez que M0 for para nível lógico 1 será acionado a função de Beep. 
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Sintaxe para as memórias na programação: 

Device 
Status 

Examples 
Examples of Use 

X : BIT device @[X:No: *1] @[X:0:P001], @[X:P001] 

S : SHORT(16bit) device @[S:No: *1] @[S:0:P000], @[S:2:#1:P000] 

L : INT (32 bit) device @[L:No: *1] @[L:0:P000], @[L:P000] 

W : UNSIGNED SHORT(16 bit)  @[W:No: *1] @[W:0:P000], @[W:1:#3:P000] 

D : UNSIGNED INT(32 bit)  @[D:No: *1] @[D:0:P000], @[D:#1:P000] 

F : FLOAT device @[F:No: *1] @[F:0:P000], @[F:#1:P000] 

 

 

FIM. 
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 Histórico de alarme e POP-UP 

 

1- No XP-Builder, click com o botão direito em Text Table e em seguida em Insert: 
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2- Teremos a seguinte tabela que pode ser configurada conforme a imagem abaixo:  

 

A descrição da segunda coluna “Alarme 01” é a mensagem que o usuário irá receber caso a 

condição do alarme 1, que iremos ver mais a frente, aconteça. 
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3- Click com o botão direito em History Alarm > Insert > Alarm Group: 

 

 

4- Podemos escrever na tela do Alarme Group o grupo a qual esse alarme pertence, neste 

caso Zona 03: 
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5- Em seguida click com o botão direito em Alarm Group > Insert > Alarm List: 

 

 

 

6- Configure os dados conforme a tela abaixo: 
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HX1, HX2 e HX3 são memórias internas da IHM. Caso fossemos utilizar memórias do CLP da LS, poderíamos 

usar as memórias M1, M2 e M3, por exemplo. Em Alarme Condition definimos quando a ação de alarme 

ocorrerá. Neste exemplo quando qualquer uma dessas  

 

memórias for para nível lógico alto (On) um aviso de alarme será escrito em uma tabela que criaremos a 

seguir.  

 

7- Click em History Alarm Viewer para criar a tabela na Base Screen: 
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8- Click na tela e arraste para criar a tabela e em seguida click em OK: 
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9- Crie três botões (Bit Switch - Momentary) como HX1, HX2 e HX3 respectivamente na tela 

que servirão para simular os alarmes. Toda vez que um desses botões forem apertado, será 

registrado na tabela. 

 

 

 

 

 

 

 

 

 

 

 

 

 

10- Podemos criar também uma rolagem na tela para verificar todas as ocorrências, click em 

Special Switch: 
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11- Crie um botão na tela ao lado da tabela e na janela que irá abrir, selecione dentro de 

History Alarm Viewer  a opção History Alarm Viewer Line Up: 
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12- Após criado o botão, ficará parecido com a tela abaixo: 
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13- Crie outro botão selecionando o botão já criado e utilizando o CTRL C para copiá-lo e o CTRL 

V para colar o novo botão. De dois clicks no segundo botão e altere para opção History 

Alarm Viewer Line Down: 
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14- A tela ficará mais ou menos assim: 

 

 

 

15- Agora podemos clicar no modo simulação para realizar um teste: 
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16- Apertando os botões notamos que sequencialmente vai sendo registrado na tabela. 

 

Para vermos todos os alarmes que ocorreram, podemos usar os dois botões criados ao lado direito da 

tabela, que tem a função de rolar a tela para baixo ou para cima. 
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 Criando função de POP-UP 

 

Podemos também utilizar uma função de POP-UP na tela para uma melhor visualização do 

alarme. 

17- Criando outro programa apenas para demonstrar a tela de POP-UP: 

18- Click em Windows com o botão direito e em seguida na opção Insert: 

 

 

 

 

Abrirá uma tela para que possamos configurar o design do POP-UP. Podemos clicar na tela com o 

botão direito e em seguida na opção Screen Property para mudar a cor da tela e também podemos 

inserir textos correspondentes ao alarme. 
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19- Com o POP-UP criado, vamos criar agora a função Bit Windows. Precisamos criar esta 

função, na tela onde queremos que o POP-UP abra. Caso você deseje abrir o POP-UP de 

alarme em todas as telas, podemos usar o comando CTRL C e CTRL V para copiá-lo para 

todas as telas. Pois apenas a tela que conter a função Bit Windows irá chamar o POP-UP.  
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20- Volte para a tela base e click no objeto Bit Windows, arraste na tela base para cria-lo. 

 

 

 

21- Configure a memória correspondente ao alarme, neste caso foi configurada a memória 

HX1 correspondente do alarme 01. Mas poderia ser qualquer memória configurada para 

alarme no CLP. Click em Browser e localize a tela de POP -UP que foi desenhada 

anteriormente. 
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22- Para testar o programa crie um botão Bit Switch na tela como Alternative e memória 

HX1: 
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23- Podemos simular o programa para ver o resultado: 

 

 

 

 

 

 

 

 

 

 

 

FIM. 
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 Loggin com envio de E-mail 

Esta função do XP-Builder permite realizar backup’s de dados ou bit, de uma memória interna 

da IHM ou até mesmo dados de uma memória do CLP. As informações das aquisições feitas são 

gravadas primeiramente, na memória interna da IHM e posteriormente enviadas para uma área 

externa, como um CF Card, Pendrive ou Email, configuráveis dependendo do modelo da IHM.  

CONFIGURAÇÃO PARA BACKUP DE DADOS 

- Já no XP-Builder click 2x em Logging na coluna ao lado esquerdo: 
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Agora click 2x na linha em branco 1 do logging: 

 

 

- Na primeira tela do logging “Logging Device” você deve configurar qual a memória que contém os 

dados você quer realizar o backup. 
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  Logging device: você deve escolher se quer realizar o backup de um bit ou de uma Word. Você 

também escolhe qual a memória que será copiada, neste exemplo escolhemos a D500 

(memória do CLP) e a opção word.  

Se caso for escolhido Bit será feito o backup do estado da memória, se ela está em 

nível alto ou nível baixo. Se for escolhido uma Word o backup será feito dos da dos contido 

nesta word. 

 Device count: Nesta opção você deve colocar quantos registros você quer ter em sua planilha. 

O logging configura uma seqüência de duas em duas memórias, por exemplo: 

Se você configurou o Device cout para 3 conseqüentemente ele reservará seis memórias para 

backup. Como neste exemplo acima foi configurado a memória D500, se tivéssemos deixado 

o Device count em 3 o logging faria o bakup dos dados que estão armazenados nas memórias 

D500, D502 e D504. 

- Na próxima aba temos as condições para que aconteça o backup.
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 Em Periodic logging você pode configurar de quanto em quanto tempo o backup será feito ou 

você configura uma memória para ativar a inicialização do backup. Neste exemplo 

configuramos a memória M6, isso significa que toda vez que a memória M6 for para nível alto 

(de 0 para 1) os dados contidos na memória D500 serão copiados e gravados na memória 

interna da IHM. 

 As opções Rising edge e Falling edge quando marcadas, significam que o backup será feito na 

borda de subida da memória M6 ou o backup será feito na borda de descida de M6, 

respectivamente. 

 O Repeat by e Repeat Period você configura quantas vezes em um determinado período de 

tempo será permitido o backup, por exemplo, se o Repeat by estiver em 1 e o Repeat period 

no campo minutos estiver em 1 como no exemplo acima, o backup será feito uma vez por 

minuto, mesmo que a memória M6 vá várias vezes para nível lógico alto dentro deste minuto, 

isso significa que só será permitido 1 backup durante o minuto vigente. A próxima aquisição 

só será liberada no próximo minuto e só será feita quando M6 for novamente para o nível 

alto.  

Lembrando que ele reconhece a borda de subida, então M6 precisa ir do nível lógico 0 para o 

nível lógico 1 caso a opção Rising edge esteja marcada. 

 Na aba Backup Area/Buffer Manage/Backup Format podemos escolher para onde a IHM vai 

enviar os dados de backup armazenados em sua memória interna e podemos também 

configurar como os dados irão aparecer na planilha. 
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Neste exemplo selecionamos a opção USB Memory que enviará as informações de backup que 

estão na memória interna da IHM para um Pendrive. Mas para que essas informações sejam 

enviadas para o pendrive, precisamos marcar a opção Backup device e configurar uma memória 

(bit) no campo ao lado. Isto significa que quando esta memória for para nível alto a IHM inicia o 

processo de transferência para o dispositivo externo.  

 

 Em logging Area, temos duas opções importantes. A IHM vem configurada de fábrica para que 

após transferir os dados que estão em sua memória interna, para um dispositivo externo, 

automaticamente o sistema limpe sua memória interna para as próximas aquisições. Agora, 

caso esteja marcada a opção Do not clear log área at backup, isso não ocorrerá e quando 

transferir uma cópia do arquivo que contém os dados coletados para o dispositivo externo, o 

arquivo original permanecerá ocupando espaço na memória interna da IHM. 
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Caso a memória interna da IHM seja totalmente ocupada e a opção Auto backup If área full 

estiver marcada, o sistema da IHM fará um backup automático para  o dispositivo externo 

configurado. No caso dessas duas opções não estiverem marcadas e por algum motivo ocorra 

um erro na hora de enviar os dados para o dispositivo externo, estes dados ficarão ainda 

armazenados na memória interna da IHM, mesmo que ela seja desligada e poderão ser 

enviados a qualquer momento para um dispositivo externo. 

 Em Backup Device, no exemplo acima, configuramos a memória M0, isso significa que quando 

M0 passar para o nível lógico alto, todos os dados que estão na memória interna da IHM 

começarão a ser transferidos para o pendrive. Após esses dados serem copiados, a IHM avisa 

o fim da cópia ativando um bit, nesse caso configuramos a memória M1, onde esta memória 

pode ser um led na tela da IHM por exemplo, para mostrar que o processo de transferência 

foi finalizado. 

A opção Send Email after backup done poderá ser marcada caso você queira que o arquivo 

com os dados de backup seja enviado por e-mail. Lembrando que para isso precisamos configurar 

também outros campos, que serão mostrados ao fim deste procedimento. 

 

 Ainda em Backup Device temos um botão chamado Settings CSV file format. Clicando neste 

botão temos a seguinte tela: 
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Nesta tela podemos configurar como os dados aparecerão na planilha. Na coluna Data 1 a 

primeira linha será o nome da coluna que conterá os dados coletados, neste exemplo chamamos 

de mg/Nm³. Nas linhas abaixo são configurados, respectivamente: o tipo de dados que você está 

coletando, neste caso float, com no máximo 7 dígitos e mostrando sempre 2 casas decimais depois 

da virgula. Caso tivéssemos configurado o Device count, lá na primeira tela do logging, diferente 

de 1 seriam mostrados nesta tela mais colunas configuráveis como esta, nomeadas como Data 1, 

Data 2, Data 3, etc... e assim por diante. 

 

Na última aba temos que configurar o espaço de memória interna que precisamos reservar na 

IHM. O máximo de memória configurável esta descrito no manual de cada modelo de IHM. 

Lembrando que quando começamos a coletar os dados a IHM primeiramente envia esses dados 

para uma memória interna, neste caso reservamos aproximadamente 100 Kbytes de memória 

interna. 

Após essas configuração é só clicar em Ok e testar a aplicação. 
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Configuração para envio de email 

- Ainda no XP-Builder click em Common > Project Property Settings; 

- Click agora na aba auxiliary Settings e marque a opção Use E-mail function; 

- Click no botão Server Settings; 

- Configure os dados de e-mail conforme a tela abaixo: 

 

- Na aba Mail Server você deverá configurar o servidor de envio SMTP da conta de e-mail 

utilizada e a porta de envio. 
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No caso do hotmail, precisamos marcar a opção Use SSL/TLS pois o servidor do hotmail precisa 

desse tipo de autenticação, mas isso vai depender do servidor de e-mail utilizado. 

Precisamos marcar também a opção My SMTP e configurar o usuário e a senha do e-mail que 

vai enviar o arquivo em anexo. 

Após essas configurações, basta clicar em ok e toda vez que o sistema fizer um backup da 

memória interna da IHM para um dispositivo externo, um e-mail será enviado automaticamente 

com um arquivo anexo dos dados coletados. 

 

Fim. 
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 Posicionamento - Motor de Passo com CLP 

O CLP utilizado para esse tipo de aplicação tem que possuir obrigatoriamente saídas a transistor. 

 

ESQUEMA DE LIGAÇÃO:  

Devemos saber se a saída do CLP utilizado é NPN ou PNP. No caso dos CLP’s da LS todas as saídas no 

CLP são NPN. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Neste CLP a saída P40 é responsável pelos “Pulsos” do eixo X e a saída P42 é responsável pela  

“Direção” do eixo X. Para o eixo Y utilizam-se as saídas P41 para “Pulso” e P43 para “Direção”.  
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Esquema de ligação: CLP – Driver – Motor: 
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Devem-se utilizar resistores na entrada CP e DIR do driver para reduzir a tensão, pois este drive 

trabalha com 5V em suas entradas e o CLP neste caso fornece 24V em suas saídas. 

  

Configuração no XG5000: 

Click em “Embedded Parameter” > “Position”: 

 

 

Neste exemplo vamos habilitar somente o eixo X para trabalhar com a função IST e DST que será visto 

mais a frente. Em “Positioning” mude para “1: Use” para habilitar o heixo X e em “Upper/Lower Limit ” 

Mude para “0: Not Use” pois neste exemplo não usaremos sensores de limite máximo e mínimo de 

curso.  
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Existem duas maneiras de controlar o Motor de Passo com os CLP’s da LS. A função “Position” pode 

ser controlada com a função IST (Indirectly Start) ou com a função DST (Directly Start). 

 

PROGRAMAÇÃO NO CLP MODO IST: 

 

Neste modo temos uma tabela que pode ser configurada para fazer uma sequência de passos. Muito 

usada quando o motor de passo vai executar sempre os mesmos movimentos em uma sequência já 

pré-definida.  

1° Coluna - Step - Na primeira coluna encontramos o número do Step, passos que irão ser executados 

conforme a configuração do Step. A quantidade de step’s pode variar conforme o CLP usado, neste 

exemplo conseguimos notar que podemos realizar uma tarefa que contenha até 30 movimentos no eixo 

X e 30 movimentos no eixo Y quando utilizamos a função IST.
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2° Coluna – Coord. - Nesta opção é configurado o tipo de coordenada: Absoluta (ABS) ou Incremental 

(INC). 

3° Coluna – Pattern. – Nessa função temos 2 que são mais utilizadas:   

    - END : Executa o passo desta linha e para, não segue para a próxima.  

- KEEP: Executa o passo desta linha e segue a sequência para próxima linha e 

assim por diante, até  encontrar uma linha que esteja configurada com END.  

4° Coluna – Control – Nesta coluna você define se o controle deste step vai ser um controle por posição 

ou por velocidade.  

5° Coluna – Method – Nesta coluna é usada quando você deseja repetir a programação a partir de um 

step.  

Ex.: Caso a sequência de movimentos do seu programa chegou ao fim no step 6, mas você precisa 

reiniciar o programa e voltar a executá-lo do primeiro passo fazendo com que ele repita a sequência de 

step’s: 1, 2 , 3, 4, 5 e 6 novamente. No step 6 você pode configurar o Method como “REP” e na próxima 

coluna você configura o número do step para o qual você deseja que o programa vá, no nosso caso o 

step número 1. 

6° Coluna – REP Step – Continuando o exemplo acima. É nesta coluna que você aponta para qual número 

de step você deseja que o programa vá. No nosso exemplo acima desejamos que o programa faça uma 

sequência de 6 movimentos e ao término do sexto movimento inicie novamente essa sequência  pelo 

primeiro step, então neste caso,  no sexto step devemos colocar nesta coluna o número 1, indicando 

assim o início (step 1) e o fim (step6) de um looping. 

7° Coluna – Adress (pulse) – Nesta coluna você precisa definir a quantidade de pulsos que esta linha vai 

executar. O motor de passo se deslo cará de acordo com esta quantidade de Pulso. 

 Lembrando que para saber de quanto será o deslocamento em distância, vai depender não só da 

quantidade de pulsos, mas também de quantos graus o motor de passo gira com apenas um pulso e o 

diâmetro do eixo.  

8° Coluna – M code – Deixar sempre em 0. 

9° Coluna – A/D No. – Esta coluna é responsável pela rampa de aceleração e desaceleração que é 

configurada na aba Position Parameter. Podemos ter até 4 rampas configuráveis.  

10° Coluna – Speed (pls/s) – Esta coluna é responsável pela velocidade de pulsos por segundo enviado 

pela saída  do CLP, neste tutorial a saída que estamos utilizando é a P40. Quanto mais pulsos por 

segundo o CLP enviar ao driver do motor de passo, mais rápido o motor irá girar. Respeitando os limit es 

do driver e do CLP. 
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11° Coluna – Dwell (ms) – Nesta coluna você pode configurar um tempo de retardo antes de começar a 

executar a próxima linha. Por exemplo: Se a primeira linha estiver configurada com Dwell de 500 

milissegundos, o programa executará a primeira linha, aguardará meio segundo e depois disso executará 

a segunda linha. É um retardo de tempo entre linhas. 

Abaixo temos um exemplo de 3 movimentos feito na função IST:  

 

 

Step 1: Iniciará o movimento em coordenadas incrementais se deslocando o motor de passo 5000 pulsos 

em uma velocidade de 1000 pulsos por segundo, terminando esse trajeto ele aguardará 3 segundos 

antes de executar a linha 2. 

Step 2: Continuará o movimento, porém agora em sentido contrário pois irá para o endereço -5000. 

Como neste momento o motor se encontra no pulso 5000 ele voltará -5000 pulsos, consequentemente 

ele irá voltar para a posição de origem (0) e sem esperar tempo algum irá para a terceira linha.  

Step 3: Na terceira linha o motor ira se deslocar 10000 pulsos sentido horário  e em uma velocidade de 

10000 pulsos por segundo, irá aguardar 2 segundos e irá para a primeira linha repetindo todos os 

movimentos em um looping. 

Para acionar a função IST colocamos uma memória M6, onde a função IST como as outras funções 

do Positioning só reconhecerá a borda de subida deste contato, então podemos utilizar o contato 

F3 ou sF1(P) do XG5000. 
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Depois da tabela configurada, fica muito simples utilizar a função IST. P ara isso bastar apertar a tecla 

F10 do teclado e escrever IST.  

Descrição dos parâmetros : 

1° Parâmetro (0) - sl  – O primeiro parâmetro é responsável pelo número do SLOT. O slot 0 significa que 

o driver do motor de passo está ligado direto no CLP. Caso seja utilizado um módulo de expansão de 

posicionamento conectado ao CLP, o número do slot será o número referente a quantidade de módulos 

que se encontram conectados no CLP, por exemplo: Se você possuí um CLP e três módulos conectado a 

sua lateral e o módulo de posicionamento é o terceiro módulo, o número do slot será 3 e assim por 

diante. 

2° Parâmetro (0) - ax – Este parâmetro é responsável pelo eixo que você deseja movimentar, para o eixo 

X você deve entrar com o valor “0”, caso queria comandar o eixo Y o valor do segundo parâmetro deve 

ser “1”. 

3° Parâmetro: (1) (n1) – Este parâmetro é responsável pelo número do step a ser executado. O número 

1 indica que o programa vai iniciar a execução pela primeira linha. Ao acionarmos a memória M6 iniciará 

o movimento da primeira linha e caso esta primeira linha estiver configurada como KEEP ela irá terminar 

o movimento e seguir para a segunda linha e assim por diante. Lembrando que para o movimento do 

motor acontecer, precisamos antes dar um pulso na função FLT para mo strar ao programa onde é a 

origem do movimento e só depois desta ação o IST irá funcionar.  
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PROGRAMAÇÃO NO CLP MODO DST: 

 

K04291 – Tem a função JOG no sentido horário, esta função normalmente é utilizada para fazer o motor 

girar ao apertar um botão do tipo Push-Button e parar de girar ao soltar o botão. Na IHM pode ser 

utilizado com um botão (Bit Switch) do tipo “Momentary”: 

                                                                      

K04292 – Tem a mesma função que a citada acima, porém para o sentindo anti -horário. 

 

FLT – A função FLT serve para zerar a posição corrente. No momento em que a memória M2, deste 

exemplo, for para nível lógico 1, o programa entenderá que ali é a origem do percurso e irá mandar para 

zero o número de pulso da posição corrente, ficando pronto para receber a próxima posição (quantidade 

de pulsos) para se deslocar considerando que está partindo do pulso zero. A função FLT 

obrigatoriamente tem que receber um pulso na primeira vez que o programa for executado. Pode 

também ser utilizada novamente caso você deseje zerar os pulsos da posição corrente.  
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DST – A primeira função de DST que temos no programa está sendo acionada pela memória M0003. Esta 

função tem como objetivo fornecer ao programa todos os parâmetros necessários  

 

para o motor de passo entrar em operação. Você pode nessa função colocar valores fixos, ou memórias 

para que o usuário, mais tarde, entre com os valores pela IHM. Neste exemplo fizemos as duas maneiras 

para demonstrar. Nesta primeira função DST temos:  

 1° Parâmetro: 0 (sl) – O primeiro parâmetro é responsável pelo número do SLOT. O slo t 0 

significa que o driver do motor de passo está ligado direto no CLP. Caso seja utilizado um módulo de 

expansão de posicionamento conectado ao CLP, o número do slot será o número referente a quantidade 

de módulos que se encontram conectados no CLP, por exemplo: Se você possuí um CLP e três módulos 

conectado a sua lateral e o módulo de posicionamento é o terceiro módulo, o número do slot na função 

DST será 3 e assim por diante. 

 2° Parâmetro: D0000 (ax) – Este parâmetro é responsável pelo eixo que você deseja 

movimentar, para o eixo X você deve entrar com o valor “0”, caso queria comandar o eixo Y o valor do 

segundo parâmetro deve ser “1”. 

 3° Parâmetro: D0005 (Target Position) - Este parâmetro serve para configurar a posição. É 

número de pulsos que o CLP vai enviar para o driver do motor de passo. A posição irá depender de 

quantos graus o motor de passo gira com um pulso. 

 4° Parâmetro: D0010 (Target Speed) – Este parâmetro é responsável pela velocidade de pulsos 

por segundo enviado pela saída do CLP, neste tutorial a saída que estamos utilizando é a P40. Quanto 

mais pulsos por segundo o CLP enviar ao driver do motor de passo, mais rápido o motor irá girar. 

Respeitando os limites do driver do motor de passo e do CLP. 

 5° Parâmetro: D0015 (Dwell Time) – Este parâmetro proporciona um retardo de tempo após a 

operação ser realizada. É mais utilizado quando utilizamos aquela tabela citada acima (X-Axis Data), onde 

você configura uma quantidade de linhas para realizar uma série de sequências. Então quando o 

programa finalizar a execução de uma linha, ele espera um tempo configurado, em milissegundos, no 

Dwell Time e só depois inicia a próxima linha. Se você deixar este parâmetro em zero, o programa seguirá 

para o próximo passo sem retardo de tempo. 

 6° Parâmetro: D0020 (Mcode) – Deixar sempre em zero. 

 7° Parâmetro: D0025 (Control Word) – Este parâmetro é responsável pela definição do tipo de 

coordenada que você vai utilizar, Incremental ou absoluta e é também responsável pelo tipo de controle, 

Posição ou Velocidade e precisamos configurá-lo através dos 16 bits de uma Word, onde usaremos 

apenas o bit 0 e o bit 4: 
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Bit 0 Posição: 0 Velocidade: 1 

Bit 4 Absoluto : 0 Incremental: 1 

 

 

  Seguindo o raciocínio da tabela acima, temos: 

Tipo Binário Hexadecimal (h) 

Posição/ Absoluto 0000000000000000 0 

Velocidade / Incremental 0000000000010001 11 

Posição / Incremental 0000000000010000 10 

Absoluto / Velocidade 0000000000000001 1 

    

 O número colocado nesse parâmetro deve ser em hexadecimal 

 

 A próxima função DST que está sendo acionada pela memória M0004 tem a função de mandar 

o motor novamente para a posição de origem (posição 0). Essa posição de origem é a mesma posição 

quando a função FLT foi acionada anteriormente indicando onde seria a posição 0.  

 

STP – Função de Stop, utilizada para parar o giro do motor. O primeiro parâmetro diz respeito ao número 

de slot, o segundo parâmetro ao eixo (X = 0  /  Y = 1) e o terceiro parâmetro é o tempo de desaceleração.  

K0422 – Mostra a posição corrente do eixo X. 
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Programação Completa: 

 

 

 

FIM. 
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 Password - XG5000 e CLP: 

 

- Password para “abrir arquivo” do XG5000: 

- No XG5000: 

1. Click com o botão direito no nome do projeto e em seguida click em propriedades: 
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2. Insira a senha, confirme e click em OK: 

 

3. Caso futuramente o usuário precise excluir a senha, digite a senha no campo “Previous 

password” e click em delete conforme a figura abaixo: 
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- Password para o “Programa do CLP ”: 

 

1- Para colocar uma senha na programação do CLP, depois de conectado com o CLP, no 

XG5000, click em: Online > PLC Information > Password. Digite a senha, confirme e click em 

Change. 

 

Pronto, a senha já foi transferida para o CLP. Caso o usuário queria se conectar ao CLP futuramente 

ou queira fazer um Upload do programa nele contido, o software exigirá a senha. 

Para deletar a senha, siga o passo 3 da página anterior. 
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- Limpando todos os parâmetros do CLP: 

1- Caso o usuário esqueça a senha que foi configurada no CLP, ele tem a alternativa de limpar os 

parâmetros do CLP. Só lembrando que esse comando apaga todas as senhas, parâmetros e 

qualquer programa nele contido.  

 Click em Online > Clear All PLC > Sim: 

  

Para realizar essa operação o CLP não precisa estar conectado. 

 

FIM. 
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 Password - XP-Builder e IHM 

- Password para “abrir arquivo ou realizar upload da IHM” no XP-Builder: 

 

- No XP-Builder: 

1. Click em Project > Project Password: 

 

 

2. Insira a senha, confirme e click em Apply: 
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Transfira o programa para a IHM. Agora para abrir ou realizar um Upload do programa, o 

software exigirá a senha configurada. 

 

3. Caso futuramente o usuário precise excluir a senha, digite a senha no campo “Old password” 

e click em delete conforme a figura abaixo: 

 

4. Transfira o programa para a IHM. 

 

FIM. 
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 PWM: 

 

Configuração no XG5000: 

Click em “Embedded Parameter” > “Position”: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Neste exemplo vamos habilitar somente o eixo X, mas se desejar trabalhar com a segunda saída 

rápida, habilite o eixo Y da mesma maneira. 
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M00000 – Aciona a função PWM. 

D00000 – Período total do ciclo em milissegundos. 

D00001 – Porcentagem do “ciclo total” em que o sinal ficará em nível lógico alto. 

 

  

Neste exemplo, podemos concluir que o tempo total do ciclo é de 10 segundos e a saída ficará 

acionada em nível lógico alto por 9 segundos e 1 segundo em nível lógico baixo. 

 

OBS.: Sempre que o tempo (D00000) ou a porcentagem do nível lógico alto (D00001) forem 

alterados, o programa necessitará que a memória M00000 seja desacionada e acionada novamente 

para atualizar a mudança. 

 

FIM. 
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 Comunicação Modbus - RTU: CLP com Inversor de Frequência 

 

- Lendo parâmetros no Inversor de Frequência: 

- No XG5000: 

1. Click em Tools > Network Manager; 

2. New > Escolha um nome > Escolha o modelo do CLP; 

3. Click 2 vezes em 00: Embedded Cnet; 

4. Configurar Chanel 2x conforme dados da serial RS485 (baud rate padrão: 9600) e em Channel 

2 escolha: Use P2P; 

5. Cick em P2P(EIP): 

 

 

 

 

 

6 – Click 2x em P2P 01 > OK; 

7- Click 2x em P2P Channel > Em 2  Use >  P2P Driver  > S 

elecione: Modbus RTU client: 
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8- Click 2x em P2P Block: 

 

9- No index 0, configure:  

- Ch.: 2 

 - P2P Function: Escolher,  Read (Ler) / Write (Escrever)  

 - Conditional flag: M100 (p/ exemplo) – Neste campo você define qual memória terá que estar 

ativa para iniciar a comunicação. Exemplo de programação para  ficar ativando esta memória 

automaticamente. As memórias M100, M102, M103 correspondem a “Conditional Flag” de cada 

linha do P2P Block. 
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- Command Type: Continuous; 

 - Data Type: Word; 

- Data Size: 2 – Quantidade de word em sequência; 

- Destination station number: 1 - Este é o endereço que está configurado no Inversor, se você 

trabalhar com mais de um inversor poderá configurá-los na sequência: 1, 2, 3...  

 

10 – Click em Setting: 

- Read área: Neste campo se encontra o endereço que precisará que ser configurado conforme 

especificações do manual do Inversor: 

 

 

Exemplo: Dependendo do modelo do CLP para configurar o parâmetro Frequency Command 

você precisa configurar em Read área o h0005 menos 1: 0x30004 como demonstrado na figura abaixo: 
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- Save área: Neste campo você deverá escolher para qual memória será enviado os dados da 

leitura. Neste exemplo vamos escolher a memória D0. 

 

Lembre-se que anteriormente escolhemos em Data size 2, isto significa que 2 words 

serão reservadas na sequência. Como neste caso escolhemos D0000 para salvar as informações 

de h0005, consequentemente foi reservado também a memória D0001 que terá salvado as 

informações o de h0006.  Caso o data size fosse configurado para 3 poderíamos ler os 

parâmetros h0005, h0006, h0007 e salvar automaticamente em D0, D1, D2 e assim por diante. 



85 

             
Agora você precisa clicar, ainda no XG -PD, em: 

On line > connect; 

On line > Write Parameter; 

On line > Enable Link (HS Link, P2P); 

Marque a opção P2P(EIP)01 e em seguida click em Write: 
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- Escrevendo parâmetros no Inversor de Frequência: 

- Exemplo para mudar os parâmetros da borda de aceleração e desaceleração do inversor pela 

IHM. 

Figura: 

Manual Inversor.  

 

Configurar o P2P Block conforme a linha 1 da figura abaixo: 

 

 

 O setting deve ser configurado da seguinte maneira: h0007 – 1: 0x40006 
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Desta maneira os dados de h0007 que correspondem a aceleração terão que ser escrito na memória D3 

e como o Data size foi configurado para 2, consequentemente os dados de h0008 que correspondem a 

desaceleração deverão ser escritos na memória D4. 

Na programação da IHM você deverá criar dois Numeric Input e chamá-los de D3 e D4 respectivamente.  

Ao entrar com os dados em D3 ou D4, automaticamente será escrito no inversor.  

 

 

Fim. 
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 Comunicação Modbus - RTU: IHM com Inversor de Frequência 

 

ESCREVENDO VALORES NO INVERSOR DE FREQUÊNCIA: 
 
1-  Abra o XP-Builder e configure o dispositivo escravo da IHM conforme a tela abaixo:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2-  Click em Common > Project Property Settings 
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3-  Na aba “XGT Panel Settings” precisamos configurar o meio de comunicação (RS485) e a velocidade de 

comunicação da IHM com o Inversor que neste caso nos dois dispositivos serão configurados para 

9600 bps: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4-  Depois de configurado o meio de comunicação entre IHM e Inversor, precisamos saber quais 

parâmetros iremos escrever e ler no Inversor de Frequência. Neste caso estamos utilizando um 

inversor da LS modelo IG5A, então abaixo será demonstrada uma tabela que está contida no manual 

do inversor com os endereços de seus parâmetros. 
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5-  Neste exemplo iremos escrever primeiramente um valor no parâmetro Freqüência do 

Inversor. Para isso precisamos configurar diretamente no inversor a forma de alteração de 

freqüência. No Inversor da LS – IG5A temos as seguintes opções: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

No inversor da LS selecione a opção número “7” dentro do parâmetro “Frq”. 
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Agora que o inversor já está configurado para receber os dados de freqüência da IHM, vamos 

criar um “Numeric Input” na IHM que enviará o valor que digitarmos para a memória responsável no 

inversor pela freqüência. 

 
 
 
 

6-  No XP_Builder adicione um “Numeric Input” e configure conforme a tela abaixo: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note que na tabela apresentada anteriormente, a memória do inversor que comanda o 

parâmetro de frequência é a 0x0005. Por esse motivo devemos colocar no primeiro campo o número 

“4” que significa “Escrever” e no segundo campo a memória destinada a Escrita 0005. Click em OK. 

 
 
 
 



92 

             
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Coloque 2 casas após a vírgula para o valor aparecer corretamente no inversor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Transfira o programa e teste. 
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LENDO VALORES NO INVERSOR DE FREQUÊNCIA:  

 
 

 
7- Agora vamos criar um “Numeric Display” na IHM para ler um parâmetro do inversor de 

freqüência. Neste exemplo iremos ler o parâmetro que indica o valor da RPM. 

Segundo a tabela que está presente no manual do inversor, a memória 

correspondente ao parâmetro RPM é a 0x0015. Este valor de memória esta sendo 

mostrado em Hexadecimal no manual, então podemos transformar este valor em 

decimal para colocar na IHM. Transformando “15H” para decimal temos o valor “21”: 
 
 
 
 
 
 
 
 
 
 

 
8- No primeiro campo coloque o numero “3” para “Leitura” e no segundo campo a 

memória 21 correspondente ao parâmetro da RPM em decimal e click em OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



94 
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PARTINDO, REVERTENDO E PARANDO O MOTOR: 
 
 

 
9- Para partir e parar o inversor nós devemos configurar o modo de partida do inversor. No inversor LS a 

função DRV deve ser modificado para “3” conforme a tabela abaixo: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
10- Agora vamos verificar os bits específicos para função “Forward Run”, “Reverse Run”  e “Stop” que se 

encontra na mesma tabela já vista anteriormente: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Podemos observar que o bit 0 corresponde ao Stop, o bit 1 corresponde ao Avanço e o bit 2 ao Reverter.  
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11- No XP_Builder crie uma “Word Switch” e configure o primeiro campo com o número 
 

“4” pois a IHM irá escrever este bit no escravo e no segundo campo, conforme a 
tabela acima, coloque a Word “6”.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12- Configure agora qual bit da Word você quer ativar. Primeiramente queremos ativar o 

bit de STOP que segundo a tabela é o bit 0. Para ativar o bit 0 de uma Word precisamos 

escrever o numero “1” nesta Word. Exemplo: 
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A figura acima demonstra que quando apertarmos o botão de Stop será enviado o número  
1 para Word 0x006 acionando o bit 0 desta word. 
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13- Para criar o botão de “Forward Run” click novamente em “Word Switch” e configure  
o botão conforme a tela abaixo: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A figura acima demonstra que quando apertarmos o botão de Forward Run será enviado o  
número 2 para Word 0x006 acionando o bit 1 desta word. 
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14- Agora por último, vamos criar o botão “Reverse Run”. Click novamente em “Word   
Switch” e configure conforme a tela abaixo: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
A figura acima demonstra que quando apertarmos o botão de Reverse Run será enviado o  número 
4 para Word 0x006 acionando o bit 2 desta word.  
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Caso a comunicação fique lenta entre o inversor e a IHM, configure o “Wait to send” 
conforme a tela baixo: 
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Esquema de ligação do cabo de comunicação RS485 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FIM. 
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 Password com níveis na IHM 

 

No XP-Builder, click em Common > Project Property Setting: 

 

  



 

103 
 

 

Na aba Security Settings podemos inserir as senhas conforme os níveis pretendidos.  

Em Password input interval podemos inserir o tempo que senha ficará ativa para o usuário 

realizar as modificações necessárias no programa. Isso significa que se o usuário digitou a 

senha corretamente, durante esses 3 minutos a senha não precisa ser digitada novamente.  
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Para testar esta função vamos criar um botão de mudança de tela, mas agora com as senhas 

já configuradas o usuário precisará digitar esta senha para passar de uma tela para outra.  

Click em Change Screen Switch e crie um botão na tela: 

 

 

Insira o número da tela para qual você quer que ocorra a mudança. 
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Click em Extended a marque a opção Security Level e em Level defina qual Nível será 

utilizado para a tela 2 do programa, neste caso vamos deixar nível 1 que tem como senha a 

sequência numérica 1,2 e 3. 

É na função Extended que encontramos para todos os comandos a opção de inserir senha. 
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Para criar uma nova tela click em Base Screen com o botão direito e depois em Insert: 

 

 

 

 

 

 

 

 

 

Configure o botão de mudança de tela do mesmo modo, mas agora para mudar para a tela 1 

e com nível de senha 2: 
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Podemos realizar a simulação do programa para confirmar seu funcionamento: 

 

Ao clicarmos para mudar para a tela dois o programa irá pedir a senha de nível 1 (123) e para 

voltarmos a tela 2 o programa pedirá a senha de nível 2 (345). 

 

FIM. 
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 Comunicação DeviceNet 

Tutorial para Comunicação DeviceNet 

- Abrir o SYCON > click em novo; 

- Selecione DeviceNet > ok; 

- Click em Insert > Máster; 

- Em Available masters selecione o dispositivo e click em Add > ok; 

- Selecione o novo master criado; 

- Click em Setting > Master Setting > Setting > Marque “Buffered, host controlled” > ok > ok; 

- Clik em Setting > Device Assingment > click Connect COM 1,2... > Marque a COM desejada 

conforme a tela abaixo > ok: 

 

- Click Settings > Bus Parameters > verificar Baudrate (125Kbits/s) > click em OK;  
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- Click Online > Automatic Network Scan. Aguarde a tela carregar e ficará conforme abaixo: 

 

- Nesta mesma tela click em Automatic Configuration > sim > ok; 

- A tela ficará conforme abaixo: 

 

- Selecione o Master e click em Online > Download > Sim; 
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- Agora abra o XGPD (no XG5000 > Tools > Network Manager); 

- New > Nome do arquivo > Selecione o CLP > Selecione o Modelo do CLP > ok; 

- Click em Online > Connect; 

- Click em Online > Read IO Information: 

 

- Click na aba High-speed Link > Dois click High-speed Link 01 > Em Module Type selecione 

Dnet > em Slot Number selecione o numero do slot que se encontra o modulo Devinet, 

conforme a tela abaixo e click em ok: 
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- Abrirá uma tabela com vários index, click uma vez em Block e em seguida click uma vez no 

0 da primeira linha conforme a figura: 
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- Agora click em Online > Sycon Upload: 

 

- O programa preencherá o index 0 automaticamente, você precisa apenas preencher qual 

memória será utilizada para receber os dados, neste caso endereçamos a memória D0, como 

pode ser visto na tela abaixo: 

 

- Click em Online > Write Parameter e marque a opção conforme a tela abaixo e click em ok:  
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- Click em Online > Enable Link e marque a opção conforme a tela abaixo e em seguida click 

em Write > Ok > Close: 

 

 

- Click em Online > Reset > Reset Individual Module e marque a opção conforme a tela 

abaixo em seguida click em ok: 

 

 

Fim; 
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 Comunicação Profibus 

- CLP; 

- Modulo de comunicação Profibus – XGL-PMEA; 

- Dispositivo Profibus a ser comunicado; 

 

Para realizar um programa para teste de comunicação: 

- No dispositivo a ser comunicado, configure o endereço do dispositivo; 

 - Encontre o arquivo GSD do dispositivo a ser comunicado; 

- Copie e cole o arquivo GSD dentro da raiz do software Sycon (C: > LG Industrial 

Systems > Sycon > Fildbus > Profibus > GSD); 

- Conecte um cabo RS232 Fêmea/Macho entre o pc e o Módulo Profibus (XGL_PMEA); 

- Abra o software Sycon, crie um arquivo novo Profibus; 

 - Insira um mestre que nesse caso será o CLP; 

 - Selecione a opção COM-C-DPM > Add>> OK; 

- Click em Settings > Master Settings e caso não esteja marcado, marque a opção 

Buffered, host controlled; 

- Insira um slave abaixo do mestre; 

- Localize na lista o arquivo GSD e add; 

- Click em Settings > Slave Configuration; 

- Coloque o endereço que foi configurado no dispositivo a comunicar no campo 

Station Adress e no botão Append Module, adicione as entradas e saídas que 

serão utilizadas; 

- Feche qualquer programa que esteja utilizando a porta COM do pc; 

- Selecione o dispositivo Mester0, vá em Settings > Bus Parameter e selecione a 

velocidade de comunicação conforme a velocidade de comunicação do pc; 

- Click Online > Download; 

- Click no botão Connect COM1 e marque o campo COM 1: do lado esquerdo > Ok > Sim; 

- As configurações serão enviadas para o modulo de comunicação Profibus; 



 

115 
 

 

- Crie no XG5000 um novo projeto contendo apenas um END no programa; 

- No XG5000, abra o XG PD; 

 - Crie um arquivo novo e conecte; 

 - Click em Online > Read IO Information; 

 - Confira o número do Slot que se encontra o módulo Pnet 

- Click na aba High-speed Link > 2 clicks em High-speed Link 01; 

- Em Module type selecione Pnet  e em Slot Number coloque o número referente ao slot 

observado anteriormente. 

- Click em qualquer lugar na tabela cinza ao lado direito; 

- Click em online > Sycon Upload; 

- Na tabela cinza do lado direito, coloque um endereço de memória em Read área (ex: 

D0) e um endereço em Save área (ex: D50); 

- Click em Online > Write Parameter; 

- Click em Online > Reset >Reset Individual Module; 

- Marque apenas o módulo Pnet para resetar; 

- Click em Online > Enable Link e marque apenas High-speed Link 01 > Write > Ok > Close; 

 

 A comunicação já está configurada, para testar você pode enviar um dado do dispositivo 

a comunicar, entrar no XG5000 e em Monitor > Device Monitoring selecionar as memórias D 

para verificar se os dados estão chegando na memória D50 em diante, que é a memória 

responsável em receber os dados do dispositivo a comunicar conforme configurado 

anteriormente no XG PD. 

 

FIM. 

  



 

116 
 

 
Configuração de Encoder - HIGH SPEED COUNTER 

 No XG5000: 

A tabela de configuração de parâmetros da função HIGH SPEED COUNTER se encontra dentro 

de Embedded Parameter: 
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Podemos também configurar todos os parâmetros da tabela através das Flags destinadas a 

função HSC. Para acessar essas Flags, click duas vezes em Variable/Comment: 
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Memórias mais utilizadas na função HSC: 

K2600 – Channel 0 Counter Enable – habilita o canal 0 e também zera o canal 0; 

K2601 – Channel 0 Counter Internal Preset Enable – habilita a função de preset. Este valor pode 

ser configurado na tabela ou na flag; 

K2603 - Channel 0 Decrement Counter Enable – quando este bit é habilitado os pulsos começam 

a decrementar (em canal simples) independente para qual lado girar o encoder.  

K2605 - Channel 0 Revolution Per Unit Time Enable  – habilita a flag que mostra rpm.  

K2606 – Channel 0 Latch Counter Enable – quando habilitada não permite que os pulsos do 

Channel 0 counter  voltem para zero.  

K262 – Channel 0 Current Count Value – memória que recebe os pulsos do encoder.  

K264 - Channel 0 Revolution Per Unit Time – memória que recebe o valor de rpm. 

K304 - Channel0 Internal Preset Setting Value – memória onde se insere o valor de preset. 

Quando é inserido um valor X nesta memória, significa que os pulsos irão começar a contar a 

partir deste valor X.  

K301 - Channel0 Pulse input Mode – Define através da flag qual o modo de entrada do pulso. 

Exemplo: Se mover 0 para essa memória o canal será simples, caso mover o numero 3 o canal 

será CW/CCW: 
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Programação HSC – Exemplo: 
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Para configurar a função RPM precisamos verificar a quantidade de pulso do encoder que 

está sendo utilizado e configurar dois parâmetros na tabela da função HSC: 

  

 

 

 

 

Conforme estas configurações, teremos RPM, RPS, etc.  
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Na IHM: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Zerar Pulsos:  M00001 

Pulsos Encoder: D00000 

N° Voltas:  D00002 

Valor Preset:  D00004 

Habilitar Preset: M00006 

Habilitar RPM:  M00008 

RPM:   D00006 

Habilitar Decrement: M00007  

Habilitar Não Zera: M00009 

Habilitar CW/CCW: M00010 
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Esquema elétrico de ligação ENCODER - CLP: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIM. 
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XP 10 – IHM ALFA-NUMÉRICA 
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No Names Description Remark 

1 Conector de Alimentação Supplies power to the XGT Panel. 24VDC 

2 S/O Chave de Download 
Chaves para download do Sistema, 

deixar sempre em RUN. 
Default: RUN 

3 Ajuste de Brilho 
Potenciômetro para ajuste de brilho da 

tela..  

4 Conector RS-422/485 
Conector RS-422/485 para 

comunicação.  

5 ConectorRS-232C  
Conector RS-232C para comunicação ou 

programação da IHM. 
DC 5V  
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 Esquema elétrico do cabo de programação: 

 

- XGT Panel = IHM; 

- Panel Editor = Software de Programação (PC); 

 

 Esquema elétrico cabo de comunicação IHM –CLP/ Inversor de Frequência: 
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 Esquema elétrico cabo de comunicação RS232: IHM-CLP: 

 

 

 

INICIANDO UM PROJETO 

Inicie o programa “Panel Editor” e em seguida clique em Project > New Project: 
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Abrirá a seguinte tela: 

 

 

 

Em “PLC Type” iremos escolher por qual Canal iremos comunicar a IHM com o CLP e também 

precisamos escolher qual a família de CLP que estamos utilizando. Para este exemplo iremos 

utilizar o Canal 2 que possuí comunicação RS485 e o CLP utilizado é da família do XGB.  

Clicando no botão “Propriedades” teremos a seguinte tela: 
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Neste exemplo vamos alterar o Baud Rate para 9600, simplesmente para ficar igual ao Baud 

Rate padrão do CLP. O Baud Rate pode ser alterado  para qualquer velocidade conforme a 

necessidade da aplicação, apenas lembrando que o Baud Rate dos dois dispositivos, IHM e CLP 

precisam ser o mesmo para haver comunicação entre eles. 

 

 

 

 

 

 

 

 

 

 

Voltando a tela de criação do projeto, precisamos também configurar a porta e a velocidade 

de configuração. Lembrando que esta velocidade de 115200 também precisa ser configurada 

no painel de controle do Windows, pois o PC e a IHM precisam da mesma velocidade para se 

comunicar.  

Clicando em “Connection Diagram...” o software nos mostra como deve ser feito o cabo de 

programação. Após tudo configurado corretamente podemos clicar em OK. 

Teremos a seguinte tela: 
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Clicando no botão F1 conforme a imagem acima, abrirá a tela para que possamos configurar 

a função deste botão: 

 

 

Devemos indicar qual será a função de F1, tais como: acionamento de um bit, inserção de um 

valor em uma word, função de incremento ou decremento ou até mesmo como função para 

mudança de tela. 

Neste exemplo iremos deixá-lo com a função “Bit”. 

 

 

 

Em “Address” devemos selecionar o canal responsável pela comunicação IHM – CLP, canal 

este que foi configurado anteriormente como 2, então selecionamos o Ch2. 

 

 

 

 



 

130 
 

 

 

 

 

 

 

 

 

 

Clicando no ícone marcado em vermelho da figura acima, abre as opções para escolhermos 

qual Bit do CLP utilizaremos para a função do botão F1. Neste caso foi escolhida a memória 

M6 do CLP. 

 

Em “Value input”, escolhemos o comportamento deste botão:  

 - Off: Quando o botão for apertado “envia” o bit para Off; 

 - On: Quando o botão for apertado “envia” o bit para On; 

- Toggle: Quando o botão for apertado o bit é setado e ao soltar o botão o bit continua   

setado, quando este botão é apertado pela segunda vez, reseta o bit e ao soltar o 

botão o bit continua resetado, chamado também de botão alternativo; 

- Momentary On: Seta o bit enquanto o botão permanecer apertado, ao soltar o botão 

o bit volta para zero. Chamado também de Push-Button. 

Neste caso podemos deixa-lo como “Momentary On”. 
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Podemos colocar em todos os botões “F” a função que pretendemos e para cada tela da IHM 

as funções destes botões podem se diferenciar. Exemplo, na tela 1 o botão F1 está  relacionado 

a memória M6 do CLP, mas na tela 2 podemos relacionar outra memória do CLP para o mesmo 

botão F1. 

No lado direito da tela temos a barra de ferramentas, click no botão de texto para criarmos 

um texto descrevendo a função do botão F1: 

 

 

 

 

 

 

 

 

 

Vamos agora inserir uma Entrada Numérica na tela da IHM para escrevermos um valor 

numérico no CLP. Click no ícone “Numeric” e depois click na tela para inserir esta função. 
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Click duas vezes nesta função que você acabou de inserir, para abrir a tela de propriedades da 

função “Numeric”. Nesta tela podemos configurar, além de qual memória irá receber o valor 

de entrada, também o formato deste dado, total de dígitos, quantidade de casas após a 

vírgula, etc.  

Neste exemplo quem irá receber o valor será a memória de contador “C1” do CLP.  

 

 

 

 

 

 

 

Caso você não queira escrever em uma memória e sim ler a memória do CLP, você não deve 

marcar a opção ”Write Enable”.  

Depois da programação finalizada, para inserir um valor na IHM devemos pressionar o botão 

“SET” localizado na parte frontal do equipamento. O valor começará a piscar, então com as 

setas para cima, para baixo, para esquerda e para direita inserimos o valor desejado. Basta 

apertar o botão “ENT” para confirmar o valor. 

 

Podemos também inserir uma lâmpada (LED) para indicar um status de saída, ou até mesmo 

o status de um botão, assim conseguimos visualizar facilmente se este botão está ou não 

apertado. Para isso click no ícone “Lamp” na barra de tarefas ao lado direito:  
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Para este exemplo vamos inserir esta lâmpada indicadora ao lado do botão “F3”, e configurar 

o botão “F3” como um botão (do tipo toggle) para setar a memória M5, por exemplo. 

Configure a lâmpada indicadora conforme figura abaixo: 

 

 

 

 

 

 

 

 

Configure o botão “F3” conforme a figura abaixo: 

 

 

 

 

  


